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     [bookmark: pgfId-97579][bookmark: 55216]Introduction to the Cisco ASAv[bookmark: 77381]
 
    [bookmark: pgfId-108595]The Cisco Adaptive Security Virtual Appliance (ASAv) brings full firewall functionality to virtualized environments to secure data center traffic and multi-tenant environments.
 
    [bookmark: pgfId-108599]You can manage and monitor the ASAv using ASDM or CLI. Other management options may be available.
 
     
     	 [bookmark: pgfId-108603]Prerequisites for the ASAv
 
     	 [bookmark: pgfId-108607]Guidelines for the ASAv
 
     	 [bookmark: pgfId-108611]Licensing for the ASAv
 
     	 [bookmark: pgfId-114078]ASAv Interfaces and Virtual NICs
 
    
 
     
      [bookmark: pgfId-114520][bookmark: 58964]Prerequisites for the ASAv
 
     [bookmark: pgfId-114522]For hypervisor support, see Cisco ASA Compatibility.
 
    
 
     
      [bookmark: pgfId-114525][bookmark: 30088][bookmark: 44106]Guidelines for the ASAv
 
     [bookmark: pgfId-108621][bookmark: 87419]Context Mode Guidelines
 
     [bookmark: pgfId-108622]Supported in single context mode only. Does not support multiple context mode.
 
     [bookmark: pgfId-108623]Failover Guidelines
 
     [bookmark: pgfId-108624]For failover deployments, make sure that the standby unit has the same model license; for example, both units should be ASAv30s.
 
     [bookmark: pgfId-108625]Unsupported ASA Features
 
     [bookmark: pgfId-108629]The ASAv does not support the following ASA features:
 
      
      	 [bookmark: pgfId-108630]Clustering
 
      	 [bookmark: pgfId-108631]Multiple context mode
 
      	 [bookmark: pgfId-108632]Active/Active failover
 
      	 [bookmark: pgfId-108633]EtherChannels
 
      	 [bookmark: pgfId-108635]Shared AnyConnect Premium Licenses[bookmark: 51484]
 
     
 
    
 
     
      [bookmark: pgfId-114646][bookmark: 29596]Licensing for the ASAv
 
     [bookmark: pgfId-114647]The ASAv uses Cisco Smart Software Licensing. For detailed information, see Smart Software Licensing for the ASAv.
 
     [bookmark: pgfId-114693]
 
      
       
        
         
         	[bookmark: pgfId-114969]Model
  
         	[bookmark: pgfId-114971]License Requirement
  
        
 
         
         	[bookmark: pgfId-114973]ASAv5
  
         	[bookmark: pgfId-114975]Standard license
 [bookmark: pgfId-114976]See the following specifications:
 
           
           	 [bookmark: pgfId-114977]100 Mbps Throughput
 
           	 [bookmark: pgfId-114978]1 vCPU
 
           	 [bookmark: pgfId-114979]2 GB RAM
 
           	 [bookmark: pgfId-114981]100,000 concurrent firewall connections
 
           	 [bookmark: pgfId-115449]Does not support AWS
 
          
  
        
 
         
         	[bookmark: pgfId-114983]ASAv10
  
         	[bookmark: pgfId-114985]Standard license
 [bookmark: pgfId-114986]See the following specifications:
 
           
           	 [bookmark: pgfId-114987]1 Gbps Throughput
 
           	 [bookmark: pgfId-114988]1 vCPU
 
           	 [bookmark: pgfId-114989]2 GB RAM
 
           	 [bookmark: pgfId-114991]100,000 concurrent firewall connections
 
           	 [bookmark: pgfId-115478]Supports AWS
 
          
  
        
 
         
         	[bookmark: pgfId-114996]ASAv30
  
         	[bookmark: pgfId-114998]Standard license
 [bookmark: pgfId-114999]See the following specifications:
 
           
           	 [bookmark: pgfId-115000]2 Gbps Throughput
 
           	 [bookmark: pgfId-115001]4 vCPUs
 
           	 [bookmark: pgfId-115002]8 GB RAM
 
           	 [bookmark: pgfId-115004]500,000 concurrent firewall connections
 
           	 [bookmark: pgfId-115499]Supports AWS
 
          
  
        
 
        
      
 
     
 You must install a smart license on the ASAv. Until you install a license, throughput is limited to 100 Kbps so you can perform preliminary connectivity tests. A smart license is required for regular operation. 
     
 
    
 
     
      [bookmark: pgfId-113787][bookmark: 39549]ASAv Interfaces and Virtual NICs
 
     [bookmark: pgfId-113791]As a guest on a virtualized platform, the ASAv utilizes the network interfaces of the underlying physical platform. Each ASAv interface maps to a virtual NIC (vNIC).
 
      
      	 [bookmark: pgfId-113798]ASAv Interfaces
 
      	 [bookmark: pgfId-113802]Supported vNICs
 
     
 
      
       [bookmark: pgfId-113809][bookmark: 99743]ASAv Interf[bookmark: marker-113808]aces
 
      [bookmark: pgfId-113813]The ASAv includes the following Gigabit Ethernet interfaces:
 
       
       	 [bookmark: pgfId-113814]Management 0/0
 
       	 [bookmark: pgfId-113815]GigabitEthernet 0/0 through 0/8. Note that the GigabitEthernet 0/8 is used for the failover link when you deploy the ASAv as part of a failover pair.
 
      
 
     
 
      
       [bookmark: pgfId-113821][bookmark: 29558]Su[bookmark: marker-113820]pported vNICs
 
      [bookmark: pgfId-113822]The ASAv supports the following vNICs:
 
      [bookmark: pgfId-113860]
 
       
        
         
          
          	 [bookmark: pgfId-113825]vNIC Type
  
          	 [bookmark: pgfId-113827]Hypervisor Support
  
          	 [bookmark: pgfId-113829]ASAv Version
  
          	 [bookmark: pgfId-113831]Notes
  
         
 
          
          	[bookmark: pgfId-113835]VMware
  
          	[bookmark: pgfId-113989]KVM
  
         
 
          
          	 
            
            [bookmark: pgfId-113853]e1000 
           
  
          	 
            
            [bookmark: pgfId-113855] 
             Yes 
           
  
          	 
            
            [bookmark: pgfId-113993] 
             Yes 
           
  
          	 
            
            [bookmark: pgfId-113857]9.2(1) and later 
           
  
          	 
            
            [bookmark: pgfId-113859]VMware default. 
           
  
         
 
          
          	 
            
            [bookmark: pgfId-114003]Virtio 
           
  
          	 
            
            [bookmark: pgfId-114005]No 
           
  
          	 
            
            [bookmark: pgfId-114007] 
             Yes 
           
  
          	 
            
            [bookmark: pgfId-114009]9.3(2.200) and later 
           
  
          	 
            
            [bookmark: pgfId-114011]KVM default. 
           
  
         
 
         
       
 
      
 
      [bookmark: pgfId-113783]
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-129813][bookmark: 87005]Deploy the ASAv Using VMware
 
    [bookmark: pgfId-129817]You can deploy the ASAv using VMware.
 
     
     	 [bookmark: pgfId-109310]VMware Feature Support for the ASAv
 
     	 [bookmark: pgfId-109314]Prerequisites for the ASAv and VMware
 
     	 [bookmark: pgfId-109318]Guidelines for the ASAv and VMware
 
     	 [bookmark: pgfId-134460]Unpack the ASAv Software and Create a Day 0 Configuration File for VMware
 
     	 [bookmark: pgfId-129273]Deploy the ASAv Using the VMware vSphere Web Client
 
     	 [bookmark: pgfId-134465]Deploy the ASAv Using the VMware vSphere Standalone Client and a Day 0 Configuration
 
     	 [bookmark: pgfId-136208]Deploy the ASAv Using the OVF Tool and Day 0 Configuration
 
     	 [bookmark: pgfId-129274]Access the ASAv Console
 
     	 [bookmark: pgfId-129278]Upgrade the vCPU or Throughput License
 
    
 
     
      [bookmark: pgfId-113030][bookmark: 84371][bookmark: 83654][bookmark: 27432][bookmark: 74230]VMware Feature Support for the ASAv
 
     [bookmark: pgfId-113037]The following table lists the VMware feature support for the ASAv.
 
     [bookmark: pgfId-109504]
 
      
       
        
        [bookmark: pgfId-109351]Table 1 [bookmark: 57875]VMware Feature Support for the ASAv 
 
        
        
         
         	[bookmark: pgfId-109359]Feature
  
         	[bookmark: pgfId-109361]Description
  
         	[bookmark: pgfId-109363]Support (Yes/No)
  
         	[bookmark: pgfId-109365]Comment
  
        
 
         
         	[bookmark: pgfId-109367]Cold clone
  
         	[bookmark: pgfId-109369]The VM is powered off during cloning.
  
         	[bookmark: pgfId-109371]Yes
  
         	[bookmark: pgfId-109373]—
  
        
 
         
         	[bookmark: pgfId-109375]DRS
  
         	[bookmark: pgfId-109377]Used for dynamic resource scheduling and distributed power management. 
  
         	[bookmark: pgfId-109379]Yes
  
         	[bookmark: pgfId-109381]See VMware guidelines.
  
        
 
         
         	[bookmark: pgfId-109383]Hot add 
  
         	[bookmark: pgfId-109385]The VM is running during an addition.
  
         	[bookmark: pgfId-109387]No
  
         	[bookmark: pgfId-109389]—
  
        
 
         
         	[bookmark: pgfId-109391]Hot clone
  
         	[bookmark: pgfId-109393]The VM is running during cloning.
  
         	[bookmark: pgfId-109395]No
  
         	[bookmark: pgfId-109397]—
  
        
 
         
         	[bookmark: pgfId-109399]Hot removal 
  
         	[bookmark: pgfId-109401]The VM is running during removal.
  
         	[bookmark: pgfId-109403]No
  
         	[bookmark: pgfId-109405]—
  
        
 
         
         	[bookmark: pgfId-109407]Snapshot
  
         	[bookmark: pgfId-109409]The VM freezes for a few seconds. 
  
         	[bookmark: pgfId-109411]Yes
  
         	[bookmark: pgfId-109413]Use with care. You may lose traffic. Failover may occur. 
  
        
 
         
         	[bookmark: pgfId-109415]Suspend and resume
  
         	[bookmark: pgfId-109417]The VM is suspended, then resumed.
  
         	[bookmark: pgfId-109419]Yes
  
         	[bookmark: pgfId-109421]—
  
        
 
         
         	[bookmark: pgfId-109423]vCloud Director
  
         	[bookmark: pgfId-109425]Allows automated deployment of VMs.
  
         	[bookmark: pgfId-109427]No
  
         	[bookmark: pgfId-109429]—
  
        
 
         
         	[bookmark: pgfId-109431]VM migration
  
         	[bookmark: pgfId-109433]The VM is powered off during migration.
  
         	[bookmark: pgfId-109435]Yes
  
         	[bookmark: pgfId-109437]—
  
        
 
         
         	[bookmark: pgfId-109439]vMotion
  
         	[bookmark: pgfId-109441]Used for live migration of VMs.
  
         	[bookmark: pgfId-109443]Yes
  
         	[bookmark: pgfId-109445]—
  
        
 
         
         	[bookmark: pgfId-109447]VMware FT
  
         	[bookmark: pgfId-109449]Used for HA on VMs.
  
         	[bookmark: pgfId-109451]No
  
         	[bookmark: pgfId-109459]Use ASAv failover for ASAv VM failures.
  
        
 
         
         	[bookmark: pgfId-109461]VMware HA
  
         	[bookmark: pgfId-109463]Used for ESX and server failures.
  
         	[bookmark: pgfId-109465]Yes
  
         	[bookmark: pgfId-109473]Use ASAv failover for ASAv VM failures.
  
        
 
         
         	[bookmark: pgfId-109475]VMware HA with VM heartbeats 
  
         	[bookmark: pgfId-109477]Used for VM failures.
  
         	[bookmark: pgfId-109479]No
  
         	[bookmark: pgfId-109487]Use ASAv failover for ASAv VM failures.
  
        
 
         
         	[bookmark: pgfId-109489]VMware vSphere Standalone Windows Client
  
         	[bookmark: pgfId-109491]Used to deploy VMs.
  
         	[bookmark: pgfId-109493]Yes
  
         	[bookmark: pgfId-109495]—
  
        
 
         
         	[bookmark: pgfId-109497]VMware vSphere Web Client
  
         	[bookmark: pgfId-109499]Used to deploy VMs.
  
         	[bookmark: pgfId-109501]Yes
  
         	[bookmark: pgfId-109503]—
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-134500][bookmark: 48631]Prerequisites for the ASAv and VMware
 
     [bookmark: pgfId-134502]You can deploy the ASAv using the VMware vSphere Web Client, vSphere standalone client, or the OVF tool. See Cisco ASA Compatibility for system requirements.
 
     [bookmark: pgfId-109513]Security Policy for a vSphere Standard Switch
 
     [bookmark: pgfId-109514]For a vSphere switch, you can edit Layer 2 security policies and apply security policy exceptions for port groups used by the ASAv interfaces. See the following default settings:
 
      
      	 [bookmark: pgfId-109518]Promiscuous Mode:  Reject 
 
      	 [bookmark: pgfId-109519]MAC Address Changes:  Accept 
 
      	 [bookmark: pgfId-109520]Forged Transmits:  Accept 
 
     
 
     [bookmark: pgfId-134523]You may need to modify these settings for the following ASAv configurations. See the vSphere documentation for more information.
 
     [bookmark: pgfId-109583]
 
      
       
        
        [bookmark: pgfId-109524]Table 2 Port Group Security Policy Exceptions
 
        
        
         
         	 [bookmark: pgfId-109534]Security Exception
  
         	 [bookmark: pgfId-109536]Routed Firewall Mode
  
         	 [bookmark: pgfId-109540]Transparent Firewall Mode
  
        
 
         
         	[bookmark: pgfId-109546]No Failover
  
         	[bookmark: pgfId-109548]Failover
  
         	[bookmark: pgfId-109550]No Failover
  
         	[bookmark: pgfId-109552]Failover
  
        
 
         
         	 
           
           [bookmark: pgfId-109554]Promiscuous Mode 
          
  
         	 
           
           [bookmark: pgfId-109556]<Any> 
          
  
         	 
           
           [bookmark: pgfId-109558]<Any> 
          
  
         	 
           
           [bookmark: pgfId-109560]Accept 
          
  
         	 
           
           [bookmark: pgfId-109562]Accept 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-109564]MAC Address Changes 
          
  
         	 
           
           [bookmark: pgfId-109566]<Any> 
          
  
         	 
           
           [bookmark: pgfId-109568]Accept 
          
  
         	 
           
           [bookmark: pgfId-109570]<Any> 
          
  
         	 
           
           [bookmark: pgfId-109572]Accept 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-109574]Forged Transmits 
          
  
         	 
           
           [bookmark: pgfId-109576]<Any> 
          
  
         	 
           
           [bookmark: pgfId-109578]Accept 
          
  
         	 
           
           [bookmark: pgfId-109580]Accept 
          
  
         	 
           
           [bookmark: pgfId-109582]Accept 
          
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-109587][bookmark: 93687]Guidelines for the ASAv and VMware
 
     [bookmark: pgfId-109590]OVF File Guidelines
 
     [bookmark: pgfId-134588]The selection of the asav-vi.ovf or asav-esxi.ovf file is based on the deployment target:
 
      
      	 [bookmark: pgfId-136226]asav-vi—For deployment on vCenter
 
      	 [bookmark: pgfId-136244]asav-esxi—For deployment on ESXi (no vCenter)
 
     
 
     [bookmark: pgfId-134538][bookmark: 87419]Failover Guidelines
 
     [bookmark: pgfId-133508]For failover deployments, make sure that the standby unit has the same model license; for example, both units should be ASAv30s.
 
     [bookmark: pgfId-109592]IPv6 Guidelines
 
     [bookmark: pgfId-109596]You cannot specify IPv6 addresses for the management interface when you first deploy the ASAv OVF file using the VMware vSphere Web Client; you can later add IPv6 addressing using ASDM or the CLI.
 
     [bookmark: pgfId-109598][bookmark: 23253]Additional Guidelines and Limitations
 
      
      	 [bookmark: pgfId-109602]The ASAv OVF deployment does not support localization (installing the components in non-English mode). Be sure that the VMware vCenter and the LDAP servers in your environment are installed in an ASCII-compatible mode.
 
      	 [bookmark: pgfId-109606]You must set your keyboard to United States English before installing the ASAv and for using the VM console.
 
      	 [bookmark: pgfId-109610]The memory allocated to the ASAv is sized specifically for the Throughput Level. Do not change the memory setting or any vCPU hardware settings in the  Edit Settings dialog box unless you are requesting a license for a different Throughput Level. Under-provisioning can affect performance, and over-provisioning causes the ASAv to warn you that it will reload; after a waiting period (24 hours for 100-125% over-provisioning; 1 hour for 125% and up), the ASAv will reload.
 
     
 If you need to change the memory or vCPU hardware settings, use only the values documented in 
     Licensing for the ASAv. Do not use the VMware-recommended memory configuration minimum, default, and maximum values. 
     
 
     [bookmark: pgfId-109631]Use the ASAv show vm and show cpu commands or the ASDM Home > Device Dashboard > Device Information > Virtual Resources tab or the Monitoring > Properties > System Resources Graphs > CPU pane to view the resource allocation and any resources that are over- or under-provisioned.
 
      
      	 [bookmark: pgfId-109639][bookmark: 54506]During ASAv deployment, if you have a host cluster, you can either provision storage locally (on a specific host) or on a shared host. However, if you try to vMotion the ASAv to another host, using any kind of storage (SAN or local) causes an interruption in connectivity.
 
      	 [bookmark: pgfId-109643]If you are running ESXi 5.0, the vSphere Web Client is not supported for ASAv OVF deployment; use the vSphere client instead.
 
     
 
    
 
     
      [bookmark: pgfId-134620][bookmark: 27615]Unpack the ASAv Software and Create a Day 0 Configuration File for VMware
 
     [bookmark: pgfId-136260]You can prepare a Day 0 configuration file before you launch the ASAv. This file is a text file that contains the ASAv configuration that will be applied when the ASAv is launched. This initial configuration is placed into a text file named “day0-config” in a working directory you chose, and is manipulated into a day0.iso file that is mounted and read on first boot. At the minimum, the Day 0 configuration file must contain commands that will activate the management interface and set up the SSH server for public key authentication, but it can also contain a complete ASA configuration. A default day0.iso containing an empty day0-config is provided with the release. The day0.iso file (either your custom day0.iso or the default day0.iso) must be available during first boot.
 To automatically license the ASAv during initial deployment, place the Smart Licensing Identity (ID) Token that you downloaded from the Cisco Smart Software Manager in a text file named ‘idtoken’ in the same directory as the Day 0 configuration file. 
     
 
     [bookmark: pgfId-136318]Note: If you want to deploy the ASAv in transparent mode, you must use a known running ASA config file in transparent mode as the Day 0 configuration file. This does not apply to a Day 0 configuration file for a routed firewall.
 
     [bookmark: pgfId-136201]Note: We are using Linux in this example, but there are similar utilities for Windows.
 
     [bookmark: pgfId-134716]Procedure
 
     [bookmark: pgfId-134884] 1. Download the ZIP file from Cisco.com, and save it to your local disk:
 
     [bookmark: pgfId-134885]http://www.cisco.com/go/asa-software
 
     [bookmark: pgfId-134703]Note: A Cisco.com login and Cisco service contract are required.
 
     [bookmark: pgfId-134974] 2. Unzip the file into a working directory. Do not remove any files from the directory. The following files are included:
 
     [bookmark: pgfId-134975]— asav-vi.ovf—For vCenter deployments.
 
     [bookmark: pgfId-134976]— asav-esxi.ovf—For non-vCenter deployments.
 
     [bookmark: pgfId-134977]— boot.vmdk—Boot disk image.
 
     [bookmark: pgfId-134981]— disk0.vmdk—ASAv disk image.
 
     [bookmark: pgfId-134982]— day0.iso—An ISO containing a day0-config file and optionally an idtoken file.
 
     [bookmark: pgfId-134983]— asav-vi.mf—Manifest file for vCenter deployments.
 
     [bookmark: pgfId-135055]— asav-esxi.mf—Manifest file for non-vCenter deployments.
 
     [bookmark: pgfId-136346] 3. Enter the CLI configuration for the ASAv in a text file called “day0-config”. Add interface configurations for the three interfaces and any other configuration you want.
 
     [bookmark: pgfId-136368]The fist line should begin with the ASA version. The day0-config should be a valid ASA configuration. The best way to generate the day0-config is to copy the desired parts of a running config from an existing ASA or ASAv. The order of the lines in the day0-config is important and should match the order seen in an existing show run command output.
 
     [bookmark: pgfId-135070]Example:
 
      
      [bookmark: pgfId-135071]ASA Version 9.4.1 
     
 
      
      [bookmark: pgfId-135072]! 
     
 
      
      [bookmark: pgfId-135073]interface management0/0 
     
 
      
      [bookmark: pgfId-135074]nameif management 
     
 
      
      [bookmark: pgfId-135075]security-level 100 
     
 
      
      [bookmark: pgfId-135076]ip address 192.168.1.1 255.255.255.0 
     
 
      
      [bookmark: pgfId-135077]no shutdown 
     
 
      
      [bookmark: pgfId-135078]interface gigabitethernet0/0 
     
 
      
      [bookmark: pgfId-135079]nameif inside 
     
 
      
      [bookmark: pgfId-135080]security-level 100 
     
 
      
      [bookmark: pgfId-135081]ip address 10.1.1.2 255.255.255.0 
     
 
      
      [bookmark: pgfId-135082]no shutdown 
     
 
      
      [bookmark: pgfId-135083]interface gigabitethernet0/1 
     
 
      
      [bookmark: pgfId-135084]nameif outside 
     
 
      
      [bookmark: pgfId-135085]security-level 0 
     
 
      
      [bookmark: pgfId-135086]ip address 198.51.100.2 255.255.255.0 
     
 
      
      [bookmark: pgfId-135087]no shutdown 
     
 
      
      [bookmark: pgfId-135088]http server enable 
     
 
      
      [bookmark: pgfId-135089]http 192.168.1.0 255.255.255.0 management 
     
 
      
      [bookmark: pgfId-135090]crypto key generate rsa modulus 1024 
     
 
      
      [bookmark: pgfId-135091]username AdminUser password paSSw0rd 
     
 
      
      [bookmark: pgfId-135092]ssh 192.168.1.0 255.255.255.0 management 
     
 
      
      [bookmark: pgfId-135093]aaa authentication ssh console LOCAL 
     
 
      
      [bookmark: pgfId-135094]call-home 
     
 
      
      [bookmark: pgfId-135095]http-proxy 10.1.1.1 port 443 
     
 
      
      [bookmark: pgfId-135096]license smart 
     
 
      
      [bookmark: pgfId-135097]feature tier standard 
     
 
      
      [bookmark: pgfId-135098]throughput level 2G 
     
 
     [bookmark: pgfId-135209] 4. (Optional) Download the Smart License identity token file issued by the Cisco Smart Software Manager to your PC.
 
     [bookmark: pgfId-136394] 5. (Optional) Copy the ID token from the download file and put it in a text file named ‘idtoken’ that only contains the ID token.
 
     [bookmark: pgfId-135227]The Identity Token automatically registers the ASAv with the Smart Licensing server.
 
     [bookmark: pgfId-135286] 6. Generate the virtual CD-ROM by converting the text file to an ISO file:
 
      
      [bookmark: pgfId-135287]stack@user-ubuntu:-/KvmAsa$ sudo genisoimage -r -o day0.iso day0-config idtoken 
     
 
      
      [bookmark: pgfId-135288]I: input-charset not specified, using utf-8 (detected in locale settings) 
     
 
      
      [bookmark: pgfId-135289]Total translation table size: 0 
     
 
      
      [bookmark: pgfId-135290]Total rockridge attributes bytes: 252 
     
 
      
      [bookmark: pgfId-135291]Total directory bytes: 0 
     
 
      
      [bookmark: pgfId-135292]Path table size (byptes): 10 
     
 
      
      [bookmark: pgfId-135293]Max brk space used 0 
     
 
      
      [bookmark: pgfId-135294]176 extents written (0 MB) 
     
 
      
      [bookmark: pgfId-135295]stack@user-ubuntu:-/KvmAsa$ 
     
 
     [bookmark: pgfId-135243] 7. Compute a new SHA1 value on Linux for the day0.iso:
 
      
      [bookmark: pgfId-135375]openssl dgst -sha1 day0.iso 
     
 
      
      [bookmark: pgfId-135379]SHA1(day0.iso)= e5bee36e1eb1a2b109311c59e2f1ec9f731ecb66 day0.iso 
     
 
     [bookmark: pgfId-135380] 8. Include the new checksum in the asav-vi.mf file in the working directory and replace the day0.iso SHA1 value with the newly generated one.
 
     [bookmark: pgfId-135382]Example.mf file
 
      
      [bookmark: pgfId-135383]SHA1(asav-vi.ovf)= de0f1878b8f1260e379ef853db4e790c8e92f2b2 
     
 
      
      [bookmark: pgfId-135384]SHA1(disk0.vmdk)= 898b26891cc68fa0c94ebd91532fc450da418b02 
     
 
      
      [bookmark: pgfId-135385]SHA1(boot.vmdk)= 6b0000ddebfc38ccc99ac2d4d5dbfb8abfb3d9c4 
     
 
      
      [bookmark: pgfId-135386]SHA1(day0.iso)= e5bee36e1eb1a2b109311c59e2f1ec9f731ecb66 
     
 
     [bookmark: pgfId-135387] 9. Copy the day0.iso file into the directory where you unzipped the ZIP file. You will overwrite the default (empty) day0.iso file.
 
    
 
     
      [bookmark: pgfId-109655][bookmark: 57037]Deploy the ASAv Using the VMware vSphere Web Client
 
     [bookmark: pgfId-122905]This section describes how to deploy the ASAv using the VMware vSphere Web Client. The Web Client requires vCenter. If you do not have vCenter, see Deploy the ASAv Using the VMware vSphere Standalone Client and a Day 0 Configuration or Deploy the ASAv Using the OVF Tool and Day 0 Configuration.
 
      
      	 [bookmark: pgfId-109660]Access the vSphere Web Client and Install the Client Integration Plug-In
 
      	 [bookmark: pgfId-109664]Deploy the ASAv Using the VMware vSphere Web Client
 
     
 
      
       [bookmark: pgfId-109666][bookmark: 79340]Access the vSphere Web Client and Install the Client Integration Plug-In
 
      [bookmark: pgfId-109667]This section describes how to access the vSphere Web Client. This section also describes how to install the Client Integration Plug-In, which is required for ASAv console access. Some Web Client features (including the plug-in) are not supported on the Macintosh. See the VMware website for complete client support information.
 
      [bookmark: pgfId-109672]Procedure
 
      [bookmark: pgfId-109674] 1. [bookmark: 93179]Launch the VMware vSphere Web Client from your browser:
 
      [bookmark: pgfId-109675]https://vCenter_server:port/vsphere-client/
 
      [bookmark: pgfId-109676]By default, the port is 9443.
 
      [bookmark: pgfId-109680] 2. (One time only) Install the Client Integration Plug-in so that you can access the ASAv console.
 
      [bookmark: pgfId-109681] a. In the login screen, download the plug-in by clicking Download the Client Integration Plug-in.
 
      [bookmark: pgfId-109685]
 
       
       [image: ] 
      
 
      [bookmark: pgfId-109686] b. Close your browser and then install the plug-in using the installer.
 
      [bookmark: pgfId-109687] c. After the plug-in installs, reconnect to the vSphere Web Client.
 
      [bookmark: pgfId-109688] 3. Enter your username and password, and click Login, or check the Use Windows session authentication check box (Windows only).
 
     
 
      
       [bookmark: pgfId-109694][bookmark: 38452]Deploy the ASAv Using the VMware vSphere Web Client
 
      [bookmark: pgfId-135564]To deploy the ASAv, use the VMware vSphere Web Client (or the vSphere Client) and a template file in the open virtualization format (OVF). You use the Deploy OVF Template wizard in the vSphere Web Client to deploy the Cisco package for the ASAv. The wizard parses the ASAv OVF file, creates the virtual machine on which you will run the ASAv, and installs the package.
 
      [bookmark: pgfId-135568]Most of the wizard steps are standard for VMware. For additional information about the Deploy OVF Template, see the VMware vSphere Web Client online help.
 
      [bookmark: pgfId-113004]Before You Begin
 
      [bookmark: pgfId-109713]You must have at least one network configured in vSphere (for management) before you deploy the ASAv.
 
      [bookmark: pgfId-109717]Procedure
 
      [bookmark: pgfId-109721] 1. Download the ASAv ZIP file from Cisco.com, and save it to your PC:
 
      [bookmark: pgfId-109723]http://www.cisco.com/go/asa-software
 A Cisco.com login and Cisco service contract are required. 
      
 
      [bookmark: pgfId-109725] 2. In the vSphere Web Client Navigator pane, click vCenter.
 
      [bookmark: pgfId-109726] 3. Click Hosts and Clusters.
 
      [bookmark: pgfId-109730] 4. Right-click the data center, cluster, or host where you want to deploy the ASAv, and choose Deploy OVF Template.
 
      [bookmark: pgfId-109735]The Deploy OVF Template wizard appears.
 
      [bookmark: pgfId-109736] 5. Follow the wizard screens as directed.
 
      [bookmark: pgfId-109740] 6. In the Setup networks screen, map a network to each ASAv interface that you want to use.
 
       
        
         
          
          	[bookmark: pgfId-112468]Network Adapter ID
  
          	[bookmark: pgfId-112473]ASAv Interface ID
  
         
 
          
          	 
            
            [bookmark: pgfId-112475]Network Adapter 1 
           
  
          	 
            
            [bookmark: pgfId-112477]Management0/0 
           
  
         
 
          
          	 
            
            [bookmark: pgfId-112479]Network Adapter 2 
           
  
          	 
            
            [bookmark: pgfId-112481]GigabitEthernet0/0 
           
  
         
 
          
          	 
            
            [bookmark: pgfId-112483]Network Adapter 3 
           
  
          	 
            
            [bookmark: pgfId-112485]GigabitEthernet0/1 
           
  
         
 
          
          	 
            
            [bookmark: pgfId-112487]Network Adapter 4 
           
  
          	 
            
            [bookmark: pgfId-112489]GigabitEthernet0/2 
           
  
         
 
          
          	 
            
            [bookmark: pgfId-112491]Network Adapter 5 
           
  
          	 
            
            [bookmark: pgfId-112493]GigabitEthernet0/3 
           
  
         
 
          
          	 
            
            [bookmark: pgfId-112495]Network Adapter 6 
           
  
          	 
            
            [bookmark: pgfId-112497]GigabitEthernet0/4 
           
  
         
 
          
          	 
            
            [bookmark: pgfId-112499]Network Adapter 7 
           
  
          	 
            
            [bookmark: pgfId-112501]GigabitEthernet0/5 
           
  
         
 
          
          	 
            
            [bookmark: pgfId-112503]Network Adapter 8 
           
  
          	 
            
            [bookmark: pgfId-112505]GigabitEthernet0/6 
           
  
         
 
          
          	 
            
            [bookmark: pgfId-112507]Network Adapter 9 
           
  
          	 
            
            [bookmark: pgfId-112509]GigabitEthernet0/7 
           
  
         
 
          
          	 
            
            [bookmark: pgfId-112511]Network Adapter 10 
           
  
          	 
            
            [bookmark: pgfId-112513]GigabitEthernet0/8 
           
  
         
 
         
       
 
      
 
      [bookmark: pgfId-112518]You do not need to use all ASAv interfaces; however, the vSphere Web Client requires you to assign a network to all interfaces. For interfaces you do not intend to use, you can simply leave the interface disabled within the ASAv configuration. After you deploy the ASAv, you can optionally return to the vSphere Web Client to delete the extra interfaces from the Edit Settings dialog box. For more information, see the vSphere Web Client online help.
 For failover/HA deployments, GigabitEthernet 0/8 is pre-configured as the failover interface. 
      
 
      [bookmark: pgfId-133731] 7. If your network uses an HTTP proxy for Internet access, you must configure the proxy address for smart licensing in the Smart Call Home Settings area. This proxy is also used for Smart Call Home in general.
 
      [bookmark: pgfId-130245] 8. [bookmark: 57703]For failover/HA deployments, in the Customize template screen:
 
      [bookmark: pgfId-112370]— [bookmark: 72849]Specify the standby management IP address.
 
      [bookmark: pgfId-122256]When you configure your interfaces, you must specify an active IP address and a standby IP address on the same network. When the primary unit fails over, the secondary unit assumes the IP addresses and MAC addresses of the primary unit and begins passing traffic. The unit that is now in a standby state takes over the standby IP addresses and MAC addresses. Because network devices see no change in the MAC to IP address pairing, no ARP entries change or time out anywhere on the network.
 
      [bookmark: pgfId-109823]— Configure the failover link settings in the HA Connection Settings area.
 
      [bookmark: pgfId-122270]The two units in a failover pair constantly communicate over a failover link to determine the operating status of each unit. GigabitEthernet 0/8 is pre-configured as the failover link. Enter the active and standby IP addresses for the link on the same network.
 
      [bookmark: pgfId-109827]
 
      [bookmark: pgfId-133210] 9. After you complete the wizard, the vSphere Web Client processes the VM; you can see the “Initialize OVF deployment” status in the Global Information area Recent Tasks pane.
 
      [bookmark: pgfId-133214]
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       [image: ] 
      
 
       
       [image: ] 
      
 
      [bookmark: pgfId-117486] 10. If the ASAv VM is not yet running, click Power On the virtual machine.
 
      [bookmark: pgfId-109857]Wait for the ASAv to boot up before you try to connect with ASDM or to the console. When the ASAv starts up for the first time, it reads parameters provided through the OVF file and adds them to the ASAv system configuration. It then automatically restarts the boot process until it is up and running. This double boot process only occurs when you first deploy the ASAv. To view bootup messages, access the ASAv console by clicking the Console tab.
 
      [bookmark: pgfId-109867] 11. For failover/HA deployments, repeat this procedure to add the secondary unit. See the following guidelines:
 
      [bookmark: pgfId-109868]— Set the same throughput level as the primary unit.
 
      [bookmark: pgfId-112314]— Enter the exact same IP address settings as for the primary unit. The bootstrap configurations on both units are identical except for the parameter identifying a unit as primary or secondary.
 
      [bookmark: pgfId-133934]Note: To successfully register the ASAv with the Cisco Licensing Authority, the ASAv requires Internet access. You might need to perform additional configuration after deployment to achieve Internet access and successful license registration.
 
     
 
    
 
     
      [bookmark: pgfId-135592][bookmark: 52369]Deploy the ASAv Using the VMware vSphere Standalone Client and a Day 0 Configuration
 
     [bookmark: pgfId-135722]To deploy the ASAv, use the VMware vSphere Client and the open virtualization format (OVF) template file (asav-vi.ovf for a vCenter deployment or asav-esxi.ovf for a non-vCenter deployment). You use the Deploy OVF Template wizard in the vSphere Client to deploy the Cisco package for the ASAv. The wizard parses the ASAv OVF file, creates the virtual machine on which you will run the ASAv, and installs the package.
 
     [bookmark: pgfId-135726]Most of the wizard steps are standard for VMware. For additional information about the Deploy OVF Template wizard, see the VMware vSphere Client online help.
 
     [bookmark: pgfId-135766]Before You Begin
 
      
      	 [bookmark: pgfId-135805]You must have at least one network configured in vSphere (for management) before you deploy the ASAv.
 
      	 [bookmark: pgfId-135806]Follow the steps in Unpack the ASAv Software and Create a Day 0 Configuration File for VMware to create the Day 0 configuration.
 
     
 
     [bookmark: pgfId-135808]Procedure
 
     [bookmark: pgfId-135809] 1. Launch the VMware vSphere Client and choose File > Deploy OVF Template.
 
     [bookmark: pgfId-135810]The Deploy OVF Template wizard appears.
 
     [bookmark: pgfId-135811] 2. Browse to the working directory where you unzipped the asav-vi.ovf file and select it.
 
     [bookmark: pgfId-135812] 3. The OVF Template details are shown. Proceed through the following screens. You do not have to change any configuration if you choose to use a custom Day 0 configuration file.
 
     [bookmark: pgfId-135814] 4. A summary of the deployment settings is shown in the last screen. Click Finish to deploy the VM.
 
     [bookmark: pgfId-135815] 5. Power on the ASAv, open the VMware console, and wait for the second boot.
 
     [bookmark: pgfId-135816] 6. SSH to the ASAv and complete your desired configuration. If you didnt have all the configuration that you wanted in the Day 0 configuration file, open a VMware console and complete the necessary configuration.
 
     [bookmark: pgfId-135818]The ASAv is now fully operational.
 
    
 
     
      [bookmark: pgfId-135798][bookmark: 83018]Deploy the ASAv Using the OVF Tool and Day 0 Configuration
 
     [bookmark: pgfId-135894]Before You Begin
 
      
      	 [bookmark: pgfId-135909]The day0.iso file is required when you are deploying the ASAv using the OVF tool. You can use the default empty day0.iso file provided in the ZIP file, or you can use a customized Day 0 configuration file that you generate. See Unpack the ASAv Software and Create a Day 0 Configuration File for VMware for creating a Day 0 configuration file.
 
      	 [bookmark: pgfId-135888]Make sure the OVF tool is installed on a Linux or Windows PC and that it has connectivity to your target ESXi server.
 
     
 
     [bookmark: pgfId-135942]Procedure
 
     [bookmark: pgfId-135961] 1. Verify the OVF tool is installed:
 
      
      [bookmark: pgfId-135962]linuxprompt# which ovftool 
     
 
     [bookmark: pgfId-135963] 2. Create a .cmd file with the desired deployment options:
 
     [bookmark: pgfId-135964]Example:
 
      
      [bookmark: pgfId-136468]linuxprompt# cat launch.cmd 
     
 
      
      [bookmark: pgfId-135965]ovftool \ 
     
 
      
      [bookmark: pgfId-135966]--name="asav-941-demo" \ 
     
 
      
      [bookmark: pgfId-135967]--powerOn \ 
     
 
      
      [bookmark: pgfId-135968]--deploymentOption=ASAv30 \ 
     
 
      
      [bookmark: pgfId-135969]--diskMode=thin \ 
     
 
      
      [bookmark: pgfId-135970]--datastore=datastore1 \ 
     
 
      
      [bookmark: pgfId-135971]--acceptAllEulas \ 
     
 
      
      [bookmark: pgfId-135972]--net:Management0-0="Portgroup_Mgmt" \ 
     
 
      
      [bookmark: pgfId-135973]--net:GigabitEthernet0-1="Portgroup_Inside" \ 
     
 
      
      [bookmark: pgfId-135974]--net:GigabitEthernet0-0="Portgroup_Outside" \ 
     
 
      
      [bookmark: pgfId-136522]--prop:HARole=Standalone \ 
     
 
      
      [bookmark: pgfId-136492]asav-esxi.ovf \ 
     
 
      
      [bookmark: pgfId-135976]vi://root@10.1.2.3/ 
     
 
     [bookmark: pgfId-135977] 3. Execute the cmd file:
 
      
      [bookmark: pgfId-135957]linuxprompt# ./launch.cmd 
     
 
     [bookmark: pgfId-136055]The ASAv is powered on; wait for the second boot.
 
     [bookmark: pgfId-136056] 4. SSH to the ASAv to complete configuration as desired. If more configuration is required, open the VMware console to the ASAv and apply the necessary configuration.
 
     [bookmark: pgfId-136048]The ASAv is now fully operational.
 
    
 
     
      [bookmark: pgfId-129850][bookmark: 59156]Access the ASAv Console[bookmark: marker-109882]
 
     [bookmark: pgfId-109884]In some cases with ASDM, you may need to use the CLI for troubleshooting. By default, you can access the built-in VMware vSphere console. Alternatively, you can configure a network serial console, which has better capabilities, including copy and paste.
 
      
      	 [bookmark: pgfId-109888]Use the VMware vSphere Console
 
      	 [bookmark: pgfId-109892]Configure a Network Serial Console Port
 
     
 
      
       [bookmark: pgfId-109894][bookmark: 30609]Use the VMware vSphere Console
 
      [bookmark: pgfId-109895]For initial configuration or troubleshooting, access the CLI from the virtual console provided through the VMware vSphere Web Client. You can later configure CLI remote access for Telnet or SSH.
 
      [bookmark: pgfId-109896]Before You Begin
 
      [bookmark: pgfId-109900]For the vSphere Web Client, install the Client Integration Plug-In, which is required for ASAv console access.
 
      [bookmark: pgfId-109901]Procedure
 
      [bookmark: pgfId-109905] 1. In the VMware vSphere Web Client, right-click the ASAv instance in the Inventory, and choose Open Console. Or you can click Launch Console on the Summary tab.
 
      [bookmark: pgfId-109906] 2. Click in the console and press Enter. Note: Press Ctrl + Alt to release the cursor.
 
      [bookmark: pgfId-109910]If the ASAv is still starting up, you see bootup messages.
 
      [bookmark: pgfId-109914]When the ASAv starts up for the first time, it reads parameters provided through the OVF file and adds them to the ASAv system configuration. It then automatically restarts the boot process until it is up and running. This double boot process only occurs when you first deploy the ASAv.
 Until you install a license, throughput is limited to 100 Kbps so that you can perform preliminary connectivity tests. A license is required for regular operation. You also see the following messages repeated on the console until you install a license: 
      
 
       
       [bookmark: pgfId-109926]Warning: ASAv platform license state is Unlicensed. 
      
 
       
       [bookmark: pgfId-109927]Install ASAv platform license for full functionality. 
      
 
      [bookmark: pgfId-109929]You see the following prompt:
 
       
       [bookmark: pgfId-109933]ciscoasa> 
      
 
      [bookmark: pgfId-109936]This prompt indicates that you a[bookmark: marker-109935]re in user EXEC mode. Only basic commands are available from user EXEC mode.
 
      [bookmark: pgfId-109940] 3. Access pr[bookmark: marker-109937]ivileged EXEC mod[bookmark: marker-109938][bookmark: marker-109939]e:
 
       
       [bookmark: pgfId-109944]ciscoasa> enable 
      
 
      [bookmark: pgfId-109946]The following prompt appears:
 
       
       [bookmark: pgfId-109947]Password: 
      
 
      [bookmark: pgfId-109949] 4. Press the Enter key to continue. By default, the password is blank. If you previously set an enable password, enter it instead of pressing Enter.
 
      [bookmark: pgfId-109950]The prompt changes to:
 
       
       [bookmark: pgfId-109954]ciscoasa# 
      
 
      [bookmark: pgfId-109956]All non-configuration commands are available in privileged EXEC mode. You can also enter configuration mode from privileged EXEC mode.
 
      [bookmark: pgfId-109957]To exit privileged mode, enter the disable, exit, or quit command.
 
      [bookmark: pgfId-109960] 5. Access global c[bookmark: marker-109958]onfigura[bookmark: marker-109959]tion mode:
 
       
       [bookmark: pgfId-109964]ciscoasa# configure terminal 
      
 
      [bookmark: pgfId-109966]The prompt changes to the following:
 
       
       [bookmark: pgfId-109970]ciscoasa(config)# 
      
 
      [bookmark: pgfId-109975]You can begin to configure the ASAv from global configuration mode. To exit global configuration mode, enter the exit, quit, or end command.
 
     
 
      
       [bookmark: pgfId-109978][bookmark: 96395]Configure a Network Serial Console Port
 
      [bookmark: pgfId-109979]For a better console experience, you can configure a network serial port singly or attached to a virtual serial port concentrator (vSPC) for console access. See the VMware vSphere documentation for details about each method. On the ASAv, you must send the console output to a serial port instead of to the virtual console. This section describes how to enable the serial port console.
 
      [bookmark: pgfId-109983]Procedure
 
      [bookmark: pgfId-109984] 1. Configure a network serial port in VMware vSphere. See the VMware vSphere documentation.
 
      [bookmark: pgfId-112791] 2. On the ASAv, create a file called “use_ttyS0” in the root directory of disk0. This file does not need to have any contents; it just needs to exist at this location:
 
      [bookmark: pgfId-109989]disk0:/use_ttyS0
 
      [bookmark: pgfId-109990]— From ASDM, you can upload an empty text file by that name using the Tools > File Management dialog box.
 
      [bookmark: pgfId-109991]— At the vSphere console, you can copy an existing file (any file) in the file system to the new name. For example:
 
       
       [bookmark: pgfId-109995]ciscoasa(config)# cd coredumpinfo 
      
 
       
       [bookmark: pgfId-109999]ciscoasa(config)# copy coredump.cfg disk0:/use_ttyS0 
      
 
      [bookmark: pgfId-110004] 3. Reload the ASAv.
 
      [bookmark: pgfId-110005]— From ASDM, choose Tools > System Reload.
 
      [bookmark: pgfId-110006]— At the vSphere console, enter reload.
 
      [bookmark: pgfId-110010]The ASAv stops sending to the vSphere console, and instead sends to the serial console.
 
      [bookmark: pgfId-110011] 4. Telnet to the vSphere host IP address and the port number you specified when you added the serial port; or Telnet to the vSPC IP address and port.
 
     
 
    
 
     
      [bookmark: pgfId-110015][bookmark: 56622]Upgrade the vCPU or Throughput License
 
     [bookmark: pgfId-133754]The ASAv uses a throughput license, which affects the number of vCPUs you can use.
 
     [bookmark: pgfId-110023]If you want to increase (or decrease) the number of vCPUs for your ASAv, you can request a new license, apply the new license, and change the VM properties in VMware to match the new values.
 The assigned vCPUs must match the ASAv Virtual CPU license or Throughput license. The RAM must also be sized correctly for the vCPUs. When upgrading or downgrading, be sure to follow this procedure and reconcile the license and vCPUs immediately. The ASAv does not operate properly when there is a persistent mismatch. 
     
 
     [bookmark: pgfId-110034]Procedure
 
     [bookmark: pgfId-110035] 1. Request a new license.
 
     [bookmark: pgfId-112917] 2. Apply the new license. For failover pairs, apply new licenses to both units.
 
     [bookmark: pgfId-112928] 3. [bookmark: 45673]Do one of the following, depending on if you use failover or not:
 
     [bookmark: pgfId-110045]— Failover—In the vSphere Web Client, power off the standby ASAv. For example, click the ASAv and then click Power Off the virtual machine, or right-click the ASAv and choose Shut Down Guest OS.
 
     [bookmark: pgfId-110055]— No Failover—In the vSphere Web Client, power off the ASAv. For example, click the ASAv and then click Power Off the virtual machine, or right-click the ASAv and choose Shut Down Guest OS.
 
     [bookmark: pgfId-110065] 4. Click the ASAv and then click Edit Virtual machine settings (or right-click the ASAv and choose Edit Settings).
 
     [bookmark: pgfId-110066]The Edit Settings dialog box appears.
 
     [bookmark: pgfId-110067] 5. Refer to the CPU memory requirement in Licensing for the ASAv to determine the correct values for the new vCPU license.
 
     [bookmark: pgfId-110068] 6. On the Virtual Hardware tab, for the CPU, choose the new value from the drop-down list.
 
     [bookmark: pgfId-110072]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-110073] 7. For the Memory, enter the new value for the RAM.
 
     [bookmark: pgfId-110074] 8. Click OK.
 
     [bookmark: pgfId-110079] 9. [bookmark: 85204]Power on the ASAv. For example, click Power On the Virtual Machine.
 
     [bookmark: pgfId-110080] 10. For failover pairs:
 
     [bookmark: pgfId-110081] a. Open a console to the active unit or Launch ASDM on the active unit.
 
     [bookmark: pgfId-110082] b. After the standby unit finishes starting up, failover to the standby unit
 
     [bookmark: pgfId-130510]- ASDM: Choose Monitoring > Properties > Failover > Status, and clicking Make Standby.
 
     [bookmark: pgfId-130522]- CLI: ciscoasa# failover active
 
     [bookmark: pgfId-110096] c. Repeat Steps 3 through 9 for the active unit.
 
     [bookmark: pgfId-134387]Related Topics
 
      
      	 [bookmark: pgfId-122594]Licensing for the ASAv
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-112612]Deploy the ASAv Using KVM
 
    [bookmark: pgfId-112616]You can deploy the ASAv using the Kernel-based Virtual Machine (KVM).
 
     
     	 [bookmark: pgfId-112620]About ASAv Deployment Using KVM
 
     	 [bookmark: pgfId-112546]Prerequisites for the ASAv and KVM
 
     	 [bookmark: pgfId-112550]Prepare the Day 0 Configuration File
 
     	 [bookmark: pgfId-112554]Prepare the Virtual Bridge XML Files
 
     	 [bookmark: pgfId-112558]Launch the ASAv
 
    
 
     
      [bookmark: pgfId-111716][bookmark: 12188]About ASAv Deployment Using KVM
 
     [bookmark: pgfId-111721]Figure 1 shows a sample network topology with ASAv and KVM. The procedures described in this chapter are based on the sample topology. You requirements will dictate the exact procedures you need. The ASAv acts as the firewall between the inside and outside networks. A separate management network is also configured.
 
     [bookmark: pgfId-111723]Figure 1 [bookmark: 11572]Sample ASAv Deployment Using KVM
 
     [bookmark: pgfId-111727]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-118420][bookmark: 10635]Prerequisites for the ASAv and KVM
 
      
      	 [bookmark: pgfId-118425]Download the ASAv qcow2 file from Cisco.com and put it on your Linux host:
 
     
 A Cisco.com login and Cisco service contract are required. 
     
 
      
      	 [bookmark: pgfId-116292]For the purpose of the sample deployment in this document, we are assuming you are using Ubuntu 14.04 LTS. Install the following packages on top of the Ubuntu 14.04 LTS host:
 
     
 
     [bookmark: pgfId-116293]— qemu-kvm 
 
     [bookmark: pgfId-118375]— libvirt-bin 
 
     [bookmark: pgfId-118378]— bridge-utils 
 
     [bookmark: pgfId-118381]— virt-manager 
 
     [bookmark: pgfId-118384]— virtinst
 
     [bookmark: pgfId-118817]— virsh tools
 
     [bookmark: pgfId-118840]— genisoimage
 
      
      	 [bookmark: pgfId-113192]Performance is affected by the host and its configuration. You can maximize the throughput of the ASAv on KVM by tuning your host. For generic host-tuning concepts, see  Network Function Virtualization Packet Processing Performance of Virtualized Platforms with Linux and Intel Architecture. 
 
      	 [bookmark: pgfId-119042]Useful optimizations for Ubuntu 14.04 include the following:
 
     
 
     [bookmark: pgfId-116813]— macvtap—High performance Linux bridge; you can use macvtap instead of a Linux bridge. Note that you must configure specific settings to use macvtap instead of the Linux bridge. 
 
     [bookmark: pgfId-116842]— Transparent Huge Pages—Increases memory page size and is on by default in Ubuntu 14.04. 
 
     [bookmark: pgfId-118997]— Hyperthread disabled—Reduces two vCPUs to one single core.
 
     [bookmark: pgfId-118998]— txqueuelength—Increases the default txqueuelength to 4000 packets and reduces drop rate.
 
     [bookmark: pgfId-118999]— pinning—Pins qemu and vhost processes to specific CPU cores; under certain conditions, pinning is a significant boost to performance.
 
      
      	 [bookmark: pgfId-117927]For information on optimizing a RHEL-based distribution, see  Red Hat Enterprise Linux6 Virtualization Tuning and Optimization Guide. 
 
      	 [bookmark: pgfId-116789]For KVM system requirements, see  Cisco ASA Compatibility .  
 
     
 
    
 
     
      [bookmark: pgfId-111742][bookmark: 80276]Prepare the Day 0 Configuration File
 
     [bookmark: pgfId-122103]You can prepare a Day 0 configuration file before you launch the ASAv. This file is a text file that contains the ASAv configuration that will be applied when the ASAv is launched. This initial configuration is placed into a text file named “day0-config” in a working directory you chose, and is manipulated into a day0.iso file that is mounted and read on first boot. At the minimum, the Day 0 configuration file must contain commands that will activate the management interface and set up the SSH server for public key authentication, but it can also contain a complete ASA configuration. The day0.iso file (either your custom day0.iso or the default day0.iso) must be available during first boot.
 
     [bookmark: pgfId-122216]Note: To automatically license the ASAv during initial deployment, place the Smart Licensing Identity (ID) Token that you downloaded from the Cisco Smart Software Manager in a text file named ‘idtoken’ in the same directory as the Day 0 configuration file.
 
     [bookmark: pgfId-122232]Note: If you want to deploy the ASAv in transparent mode, you must use a known running ASA config file in transparent mode as the Day 0 configuration file. This does not apply to a Day 0 configuration file for a routed firewall.
 
     [bookmark: pgfId-122217]Note: We are using Linux in this example, but there are similar utilities for Windows.
 
     [bookmark: pgfId-122218]Procedure
 
     [bookmark: pgfId-122259] 1. Enter the CLI configuration for the ASAv in a text file called “day0-config”. Add interface configurations for the three interfaces and any other configuration you want.
 
     [bookmark: pgfId-122292]The fist line should begin with the ASA version. The day0-config should be a valid ASA configuration. The best way to generate the day0-config is to copy the desired parts of a running config from an existing ASA or ASAv. The order of the lines in the day0-config is important and should match the order seen in an existing show run command output.
 
     [bookmark: pgfId-111746]Example:
 
      
      [bookmark: pgfId-111748]ASA Version 9.4.1 
     
 
      
      [bookmark: pgfId-122334]! 
     
 
      
      [bookmark: pgfId-122315]interface management0/0 
     
 
      
      [bookmark: pgfId-113459] nameif management 
     
 
      
      [bookmark: pgfId-111749] security-level 100 
     
 
      
      [bookmark: pgfId-111750] ip address 192.168.1.2 255.255.255.0 
     
 
      
      [bookmark: pgfId-111751] no shutdown 
     
 
      
      [bookmark: pgfId-111752]interface gigabitethernet0/0 
     
 
      
      [bookmark: pgfId-111753] nameif inside 
     
 
      
      [bookmark: pgfId-111754] security-level 100 
     
 
      
      [bookmark: pgfId-111755] ip address 10.1.1.2 255.255.255.0 
     
 
      
      [bookmark: pgfId-111756] no shutdown 
     
 
      
      [bookmark: pgfId-111757]interface gigabitethernet0/1 
     
 
      
      [bookmark: pgfId-111758] nameif outside 
     
 
      
      [bookmark: pgfId-111759] security-level 0 
     
 
      
      [bookmark: pgfId-111760] ip address 198.51.100.2 255.255.255.0 
     
 
      
      [bookmark: pgfId-111761] no shutdown 
     
 
      
      [bookmark: pgfId-113478]http server enable 
     
 
      
      [bookmark: pgfId-113474]http 192.168.1.0 255.255.255.0 management 
     
 
      
      [bookmark: pgfId-111762]crypto key generate rsa modulus 1024 
     
 
      
      [bookmark: pgfId-111763]username AdminUser password paSSw0rd 
     
 
      
      [bookmark: pgfId-111764]ssh 192.168.1.0 255.255.255.0 management 
     
 
      
      [bookmark: pgfId-111765]aaa authentication ssh console LOCAL 
     
 
     [bookmark: pgfId-111767] 2. (Optional) Download the Smart License identity token file issued by the Cisco Smart Software Manager to your computer. 
 
     [bookmark: pgfId-122339] 3. (Optional) Copy the ID token from the download file and put it a text file named ‘idtoken’ that only contains the ID token. 
 
     [bookmark: pgfId-120785] 4. (Optional) For automated licensing during initial ASAv deployment, make sure the following information is in the day0-config file:
 
     [bookmark: pgfId-120786]— Management interface IP address
 
     [bookmark: pgfId-120787]— (Optional) HTTP proxy to use for Smart Licensing
 
     [bookmark: pgfId-120788]— A route command that enables connectivity to the HTTP proxy (if specified) or to tools.cisco.com
 
     [bookmark: pgfId-120789]— A DNS server that resolves tools.cisco.com to an IP address
 
     [bookmark: pgfId-120790]— Smart Licensing configuration specifying the ASAv license you are requesting
 
     [bookmark: pgfId-116493]— (Optional) A unique host name to make the ASAv easier to find in CSSM 
 
     [bookmark: pgfId-120781] 5. Generate the virtual CD-ROM by converting the text file to an ISO file:
 
      
      [bookmark: pgfId-111768]stack@user-ubuntu:-/KvmAsa$ sudo genisoimage -r -o day0.iso day0-config idtoken 
     
 
      
      [bookmark: pgfId-111769]I: input-charset not specified, using utf-8 (detected in locale settings) 
     
 
      
      [bookmark: pgfId-111770]Total translation table size: 0 
     
 
      
      [bookmark: pgfId-111771]Total rockridge attributes bytes: 252 
     
 
      
      [bookmark: pgfId-111772]Total directory bytes: 0 
     
 
      
      [bookmark: pgfId-111773]Path table size (byptes): 10 
     
 
      
      [bookmark: pgfId-111774]Max brk space used 0 
     
 
      
      [bookmark: pgfId-111775]176 extents written (0 MB) 
     
 
      
      [bookmark: pgfId-111776]stack@user-ubuntu:-/KvmAsa$ 
     
 
     [bookmark: pgfId-119580]The Identity Token automatically registers the ASAv with the Smart Licensing server.
 
     [bookmark: pgfId-111778] 6. Repeat Steps 1 through 5 to create separate default configuration files with the appropriate IP addresses for each ASAv you want to deploy.
 
    
 
     
      [bookmark: pgfId-111781][bookmark: 35536]Prepare the Virtual Bridge XML Files
 
     [bookmark: pgfId-111782]You need to set up virtual networks that connect the ASAv guests to the KVM host and that connect the guests to each other.
 This procedure does not establish connectivity to the external world outside the KVM host. 
     
 
     [bookmark: pgfId-111784]Prepare the virtual bridge XML files on the KVM host. For the sample virtual network topology described in Prepare the Day 0 Configuration File, you need the following three virtual bridge files: virbr1.xml, virbr2.xml, and virbr3.xml (you must use these three filenames; for example, virbr0 is not allowed because it already exists). Each file has the information needed to set up the virtual bridges. You must give the virtual bridge a name and a unique MAC address. Providing an IP address is optional.
 
     [bookmark: pgfId-111788]Procedure
 
     [bookmark: pgfId-111789] 1. Create three virtual networks bridge XML files:
 
     [bookmark: pgfId-111790]virbr1.xml:
 
      
      [bookmark: pgfId-111791]<network> 
     
 
      
      [bookmark: pgfId-111792] <name>virbr1</name> 
     
 
      
      [bookmark: pgfId-111793] <bridge name='virbr1' stp='on' delay='0' /> 
     
 
      
      [bookmark: pgfId-111794] <mac address='52:54:00:05:6e:00' /> 
     
 
      
      [bookmark: pgfId-111795] <ip address='192.168.1.10' netmask='255.255.255.0' /> 
     
 
      
      [bookmark: pgfId-111796]</network> 
     
 
     [bookmark: pgfId-113831]virbr2.xml:
 
      
      [bookmark: pgfId-113766]<network> 
     
 
      
      [bookmark: pgfId-113767] <name>virbr2</name> 
     
 
      
      [bookmark: pgfId-113768] <bridge name='virbr2' stp='on' delay='0' /> 
     
 
      
      [bookmark: pgfId-113769] <mac address='52:54:00:05:6e:01' /> 
     
 
      
      [bookmark: pgfId-113770] <ip address='10.1.1.10' netmask='255.255.255.0' /> 
     
 
      
      [bookmark: pgfId-113771]</network> 
     
 
     [bookmark: pgfId-113875]virbr3.xml:
 
      
      [bookmark: pgfId-113794]<network> 
     
 
      
      [bookmark: pgfId-113795] <name>virbr3</name> 
     
 
      
      [bookmark: pgfId-113796] <bridge name='virbr3' stp='on' delay='0' /> 
     
 
      
      [bookmark: pgfId-113797] <mac address='52:54:00:05:6e:02' /> 
     
 
      
      [bookmark: pgfId-113798] <ip address='198.51.100.10' netmask='255.255.255.0' /> 
     
 
      
      [bookmark: pgfId-113799]</network> 
     
 
     [bookmark: pgfId-111798] 2. Create a script that contains the following (in our example, we will name the script virt_network_setup.sh):
 
      
      [bookmark: pgfId-111799]virsh net-create virbr1.xml 
     
 
      
      [bookmark: pgfId-111800]virsh net-create virbr2.xml 
     
 
      
      [bookmark: pgfId-111801]virsh net-create virbr3.xml  
     
 
     [bookmark: pgfId-114461] 3. Run this script to setup the virtual network. The script brings the virtual networks up. The networks stay up as long as the KVM host is running.
 
      
      [bookmark: pgfId-114462]stack@user-ubuntu:-/KvmAsa$ virt_network_setup.sh 
     
If you reload the Linux host, you must re-run the virt_network_setup.sh script. It does not persist over reboots. 
     
 
     [bookmark: pgfId-111806] 4. Verify that the virtual networks were created:
 
      
      [bookmark: pgfId-111807]stack@user-ubuntu:-/KvmAsa$ brctl show 
     
 
      
      [bookmark: pgfId-111808]bridge name bridge id STP enabled Interfaces 
     
 
      
      [bookmark: pgfId-111809]virbr0 8000.0000000000000 yes  
     
 
      
      [bookmark: pgfId-111810]virbr1 8000.5254000056eed yes virb1-nic 
     
 
      
      [bookmark: pgfId-111811]virbr2 8000.5254000056eee yes virb2-nic 
     
 
      
      [bookmark: pgfId-111812]virbr3 8000.5254000056eec yes virb3-nic 
     
 
      
      [bookmark: pgfId-111813]stack@user-ubuntu:-/KvmAsa$ 
     
 
     [bookmark: pgfId-111815] 5. Display the IP address assigned to the virbr1 bridge. This is the IP address that you assigned in the XML file. 
 
      
      [bookmark: pgfId-111816]stack@user-ubuntu:-/KvmAsa$ ip address show virbr1 
     
 
      
      [bookmark: pgfId-111817]S: virbr1: <NO-CARRIER,BROADCAST,MULTICAST,UP> mtu 1500 qdisc noqueue state DOWN 
     
 
      
      [bookmark: pgfId-111818] link/ether 52:54:00:05:6e:00 brd ff:ff:ff:ff:ff:ff 
     
 
      
      [bookmark: pgfId-111819] inet 192.168.1.10/24 brd 192.168.1.255 scope global virbr1 
     
 
      
      [bookmark: pgfId-111820] valid_lft forever preferred_lft forever 
     
 
    
 
     
      [bookmark: pgfId-111824][bookmark: 19063]Launch the ASAv
 
     [bookmark: pgfId-111825]Use a virt-install based deployment script to launch the ASAv.
 
     [bookmark: pgfId-114021]Procedure
 
     [bookmark: pgfId-114009] 1. Create a virt-install script called “virt_install_asav.sh”.
 
     [bookmark: pgfId-116572]The name of the ASAv VM must be unique across all other virtual machines (VMs) on this KVM host. The ASAv can support up to 10 networks. This example uses three networks. The order of the network bridge clauses is important. The first one listed is always the management interface of the ASAv (Management 0/0), the second one listed is GigabitEthernet 0/0 of the ASAv, and the third one listed is GigabitEthernet 0/1 of the ASAv, and so on up through GigabitEthernet0/8. The virtual NIC must be Virtio. 
 
      
      [bookmark: pgfId-116651]virt-install \ 
     
 
      
      [bookmark: pgfId-116652] --connect=qemu:///system \ 
     
 
      
      [bookmark: pgfId-116653] --network network=default,model=virtio \ 
     
 
      
      [bookmark: pgfId-116654] --network network=default,model=virtio \ 
     
 
      
      [bookmark: pgfId-116655] --network network=default,model=virtio \ 
     
 
      
      [bookmark: pgfId-116656] --name=asav \ 
     
 
      
      [bookmark: pgfId-116657] --cpu host \ 
     
 
      
      [bookmark: pgfId-116658] --arch=x86_64 \ 
     
 
      
      [bookmark: pgfId-116659] --machine=pc-1.0 \ 
     
 
      
      [bookmark: pgfId-116660] --vcpus=1 \ 
     
 
      
      [bookmark: pgfId-116661] --ram=2048 \ 
     
 
      
      [bookmark: pgfId-116662] --os-type=linux \ 
     
 
      
      [bookmark: pgfId-116663] --os-variant=generic26 \ 
     
 
      
      [bookmark: pgfId-116664] --noacpi \ 
     
 
      
      [bookmark: pgfId-116665] --virt-type=kvm \ 
     
 
      
      [bookmark: pgfId-116666] --import \ 
     
 
      
      [bookmark: pgfId-116667] --disk path=/home/kvmperf/Images/desmo.qcow2,format=qcow2,device=disk,bus=ide,cache=none \ 
     
 
      
      [bookmark: pgfId-116668] --disk path=/home/kvmperf/asav_day0.iso,format=iso,device=cdrom \ 
     
 
      
      [bookmark: pgfId-116669] --console pty,target_type=virtio \ 
     
 
      
      [bookmark: pgfId-116670] --serial tcp,host=127.0.0.1:4554,mode=bind,protocol=telnet 
     
 
     [bookmark: pgfId-116587] 2. Run the virt_install script:
 
      
      [bookmark: pgfId-111844]stack@user-ubuntu:-/KvmAsa$ ./virt_install_asav.sh 
     
 
      
      [bookmark: pgfId-111845] 
     
 
      
      [bookmark: pgfId-111846]Starting install... 
     
 
      
      [bookmark: pgfId-111847]Creating domain... 
     
 
     [bookmark: pgfId-111849]A window appears displaying the console of the VM. You can see that the VM is booting. It takes a few minutes for the VM to boot. Once the VM stops booting you can issue CLI commands from the console screen.[bookmark: 30491][bookmark: 52592]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-112612]Deploy the ASAv On the AWS Cloud
 
    [bookmark: pgfId-112616]You can deploy the ASAv on the Amazon Web Sources (AWS) cloud.
 
     
     	 [bookmark: pgfId-112620]About ASAv Deployment On the AWS Cloud
 
     	 [bookmark: pgfId-112546]Prerequisites for the ASAv and AWS
 
     	 [bookmark: pgfId-112550]Guidelines and Limitations for the ASAv and AWS
 
     	 [bookmark: pgfId-112554]Sample Network Topology for ASAv on AWS
 
     	 [bookmark: pgfId-112558]Deploy the ASAv on AWS
 
    
 
     
      [bookmark: pgfId-111716][bookmark: 12188]About ASAv Deployment On the AWS Cloud
 
     [bookmark: pgfId-121433]AWS is a public cloud environment that uses a private Xen Hypervisor. The ASAv runs as a guest in the AWS environment of the Xen Hypervisor. ASAv on AWS supports the following instance types:
 
      
      	 [bookmark: pgfId-123380]c3.large—2 vCPUs, 3.75 GB, 2 interfaces, 1 management interface
 
     
 Both the ASAv10 and ASAv30 are supported on c3.large, but we do not recommend the ASAv30 on c3.large due to resource under-provisioning. 
     
 
      
      	 [bookmark: pgfId-123382]c3.xlarge—4 vCPUs, 7.5 GB, 3 interfaces, 1 management interface
 
     
 Only the ASAv30 is supported on c3.xlarge. 
     
 
     [bookmark: pgfId-121437]Note: The ASAv does not support the Xen Hypervisor outside of the AWS environment.
 
     [bookmark: pgfId-121438]You create an account on AWS, set up the ASAv using the AWS Wizard, and chose an Amazon Machine Image (AMI). The AMI is a template that contains the software configuration needed to launch your instance.
 
     [bookmark: pgfId-121427]Note: The AMI images are not available for download outside of the AWS environment.
 
    
 
     
      [bookmark: pgfId-118420][bookmark: 10635]Prerequisites for the ASAv and AWS
 
      
      	 [bookmark: pgfId-121532]Create an account on  aws.amazon.com .
 
      	 [bookmark: pgfId-122742]License the ASAv. Until you license the ASAv, it will run in degraded mode, which allows only 100 connections and throughput of 100 Kbps. See  Smart Software Licensing for the ASAv .
 
      	 [bookmark: pgfId-122744]Interface requirements:
 
     
 
     [bookmark: pgfId-121536]— Management interface
 
     [bookmark: pgfId-121537]— Inside and outside interfaces
 
     [bookmark: pgfId-121538]— (Optional) Additional subnet (DMZ)
 
      
      	 [bookmark: pgfId-121539]Communications paths:
 
     
 
     [bookmark: pgfId-121540]— Management interface—Used to connect the ASAv to the ASDM; can’t be used for through traffic.
 
     [bookmark: pgfId-121541]— Inside interface (required)—Used to connect the ASAv to inside hosts.
 
     [bookmark: pgfId-121542]— Outside interface (required)—Used to connect the ASAv to the public network.
 
     [bookmark: pgfId-121543]— DMZ interface (optional)—Used to connect the ASAv to the DMZ network when using the c3.xlarge interface.
 
      
      	 [bookmark: pgfId-116789]For ASAv system requirements, see  Cisco ASA Compatibility .
 
     
 
    
 
     
      [bookmark: pgfId-111742][bookmark: 13743]Guidelines and Limitations for the ASAv and AWS
 
     [bookmark: pgfId-121880]The ASAv on AWS supports the following features:
 
      
      	 [bookmark: pgfId-121927]Deployment in the Virtual Private Cloud (VPC)
 
      	 [bookmark: pgfId-121928]Enhanced networking (SR-IOV) where available
 
      	 [bookmark: pgfId-121929]Deployment from Amazon Marketplace
 
      	 [bookmark: pgfId-121930]Maximum of four vCPUs per instance
 
      	 [bookmark: pgfId-121931]User deployment of L3 networks
 
      	 [bookmark: pgfId-121932]Routed mode (default)
 
     
 
     [bookmark: pgfId-121916]The ASAv on AWS does not support the following:
 
      
      	 [bookmark: pgfId-121959]Console access (management is performed using SSH or ASDM over network interfaces)
 
      	 [bookmark: pgfId-121960]IPv6
 
      	 [bookmark: pgfId-121961]VLAN
 
      	 [bookmark: pgfId-121962]Promiscuous mode (no sniffing or transparent mode firewall support)
 
      	 [bookmark: pgfId-121963]Multi-context mode
 
      	 [bookmark: pgfId-121964]Clustering
 
      	 [bookmark: pgfId-121965]ASAv native HA
 
      	 [bookmark: pgfId-121966]EtherChannel is only supported on direct physical interfaces
 
      	 [bookmark: pgfId-121967]VM import/export
 
      	 [bookmark: pgfId-121968]Amazon Cloudwatch
 
      	 [bookmark: pgfId-121969]Hypervisor agnostic packaging
 
      	 [bookmark: pgfId-121952]VMware ESXi
 
      	 [bookmark: pgfId-123110]Broadcast/multicast messages 
 
     
 
     [bookmark: pgfId-123307]These messages are not propagated within AWS so routing protocols that require broadcast/multicast do not function as expected in AWS. VXLAN can operate only with static peers.
 
      
      	 [bookmark: pgfId-123111]Gratuitous/unsolicited ARPs
 
     
 
     [bookmark: pgfId-123213]These ARPS are not accepted within AWS so NAT configurations that require gratuitous ARPs or unsolicited ARPs do not function as expected.
 
    
 
     
      [bookmark: pgfId-111781][bookmark: 84870]Sample Network Topology for ASAv on AWS
 
     [bookmark: pgfId-122012]Figure 1 shows the recommended topology for the ASAv in Routed Firewall Mode with four subnets configured in AWS for the ASAv (management, inside, outside, and DMZ).
 
     [bookmark: pgfId-122006]Figure 1 [bookmark: 10447]Sample ASAv on AWS Deployment
 
     [bookmark: pgfId-122035]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-111824][bookmark: 85428]Deploy the ASAv on AWS
 
     [bookmark: pgfId-122112]The following procedure is a top-level list of steps to set up AWS on the ASAv. For detailed steps for setup, see Getting Started with AWS.
 
     [bookmark: pgfId-114021]Procedure
 
     [bookmark: pgfId-114009] 1. Log into aws.amazon.com and choose your region.
 
     [bookmark: pgfId-122144]AWS is divided into multiple regions that are isolated from each other. The region is displayed in the upper right corner of your screen. Resources in one region do not appear in another region. Check periodically to make sure you are in the intended region.
 
     [bookmark: pgfId-122167] 2. Click My Account > AWS Management Console, and under Networking, click VPC > Start VPC Wizard, and create your VPC by choosing a single public subnet, and set up the following (you can use the default settings unless otherwise noted):
 
     [bookmark: pgfId-122222]— Inside and outside subnet—Enter a name for the VPC and the subnets.
 
     [bookmark: pgfId-122223]— Internet Gateway—Enables direct connectivity over the Internet (enter the name of the Internet gateway).
 
     [bookmark: pgfId-122260]— outside table—Add entry to enable outbound traffic to the Internet (add 0.0.0.0/0 to Internet Gateway).
 
     [bookmark: pgfId-122241] 3. Click My Account > AWS Management Console > EC2, and then click Create an Instance.
 
     [bookmark: pgfId-122285]— Select your AMI (for example Ubuntu Server 14.04 LTS).
 
     [bookmark: pgfId-122286]Use the AMI identified in the your image delivery notification.
 
     [bookmark: pgfId-122287]— Choose the instance type supported by the ASAv (for example, c3.large).
 
     [bookmark: pgfId-122288]— Configure the instance (CPUs and memory are fixed).
 
     [bookmark: pgfId-122289]— Under Advanced Details, add the Day 0 Configuration if desired. For more information on how to configure the Day 0 configuration with more information, such as Smart Licensing, see Prepare the Day 0 Configuration File.
 
     [bookmark: pgfId-122278]Sample Day 0 Configuration
 
      
      [bookmark: pgfId-122318]! ASA Version 9.4.1.200 
     
 
      
      [bookmark: pgfId-122319]interface management0/0 
     
 
      
      [bookmark: pgfId-122320]management-only 
     
 
      
      [bookmark: pgfId-122321]nameif management 
     
 
      
      [bookmark: pgfId-122322]security-level 100 
     
 
      
      [bookmark: pgfId-122323]ip address dhcp setroute 
     
 
      
      [bookmark: pgfId-122324]no shut 
     
 
      
      [bookmark: pgfId-122325]! 
     
 
      
      [bookmark: pgfId-122326]same-security-traffic permit inter-interface 
     
 
      
      [bookmark: pgfId-122327]same-security-traffic permit intra-interface 
     
 
      
      [bookmark: pgfId-122328]! 
     
 
      
      [bookmark: pgfId-122329]crypto key generate rsa modulus 2048 
     
 
      
      [bookmark: pgfId-122330]ssh 0 0 management 
     
 
      
      [bookmark: pgfId-122331]ssh timeout 30 
     
 
      
      [bookmark: pgfId-122332]username admin nopassword privilege 15 
     
 
      
      [bookmark: pgfId-122333]username admin attributes 
     
 
      
      [bookmark: pgfId-122334]service-type admin 
     
 
      
      [bookmark: pgfId-122335]! required config end 
     
 
      
      [bookmark: pgfId-122336]! example dns configuration 
     
 
      
      [bookmark: pgfId-122337]dns domain-lookup management 
     
 
      
      [bookmark: pgfId-122338]DNS server-group DefaultDNS 
     
 
      
      [bookmark: pgfId-122339]! where this address is the .2 on your public subnet 
     
 
      
      [bookmark: pgfId-122340]name-server 172.19.0.2 
     
 
      
      [bookmark: pgfId-122341]! example ntp configuration 
     
 
      
      [bookmark: pgfId-122342]name 129.6.15.28 time-a.nist.gov 
     
 
      
      [bookmark: pgfId-122343]name 129.6.15.29 time-b.nist.gov 
     
 
      
      [bookmark: pgfId-122344]name 129.6.15.30 time-c.nist.gov 
     
 
      
      [bookmark: pgfId-122345]ntp server time-c.nist.gov 
     
 
      
      [bookmark: pgfId-122346]ntp server time-b.nist.gov 
     
 
      
      [bookmark: pgfId-122375]ntp server time-a.nist.gov 
     
 
     [bookmark: pgfId-122385]— Storage (accept the defaults).
 
     [bookmark: pgfId-122386]— Tag Instance—You can create a lot of tags to classify your devices. Give it a name you can use to find it easily.
 
     [bookmark: pgfId-122387]— Security Group—Create a security group and name it. The security group is a virtual firewall for an instance to control inbound and outbound traffic.
 
     [bookmark: pgfId-122389]By default the Security Group is open to all addresses. Change the rules to only allow SSH in from addresses you will be using to access your ASAv.
 
     [bookmark: pgfId-122311]— Review your configuration and then click Launch.
 
     [bookmark: pgfId-122416] 4. Create a Key Pair.
 
     [bookmark: pgfId-122445]Give the key pair a name you will recognize and download the key to a safe place; the key can never be downloaded again. If you lose the key pair, you must destroy your instances and redeploy them again.
 
     [bookmark: pgfId-122460] 5. Click Launch Instance to deploy your ASAv.
 
     [bookmark: pgfId-122478] 6. Click My Account > AWS Management Console > EC2 > Launch an Instance > My AMIs.
 
     [bookmark: pgfId-122493] 7. Make sure that the Source/Destination Check is disabled per interface for the ASAv.
 
     [bookmark: pgfId-122515]AWS default settings only allow an instance to receive traffic for its IP address and only allow an instance to send traffic from its own IP address. To enable the ASAv to act as a routed hop, you must disable the Source/Destination Check on each of the ASAv's traffic interfaces (inside, outside, and DMZ).
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-112908][bookmark: 79743]Configure the ASAv
 
    [bookmark: pgfId-112912]The ASAv deployment pre-configures ASDM access. From the client IP address you specified during deployment, you can connect to the ASAv management IP address with a web browser. This chapter also describes how to allow other clients to access ASDM and also how to allow CLI access (SSH or Telnet). Other essential configuration tasks covered in this chapter include the license installation and common configuration tasks provided by wizards in ASDM.
 
     
     	 [bookmark: pgfId-117171]Start ASDM
 
     	 [bookmark: pgfId-117179]Perform Initial Configuration Using ASDM
 
     	 [bookmark: pgfId-112931]Advanced Configuration
 
    
 
     
      [bookmark: pgfId-112933][bookmark: 87798]Start ASDM
 
     [bookmark: pgfId-113406]Procedure
 
     [bookmark: pgfId-113407] 1. On the PC that you specified as the ASDM client, enter the following URL:
 
     [bookmark: pgfId-113408]https://asa_ip_address/admin
 
     [bookmark: pgfId-113410]The ASDM launch page appears with the following buttons:
 
     [bookmark: pgfId-113411]— Install ASDM Launcher and Run ASDM
 
     [bookmark: pgfId-113412]— Run ASDM 
 
     [bookmark: pgfId-113413]— Run Startup Wizard
 
     [bookmark: pgfId-113414] 2. To download the Launcher:
 
     [bookmark: pgfId-113415] a. Click Install ASDM Launcher and Run ASDM.
 
     [bookmark: pgfId-113416] b. Leave the username and password fields empty (for a new installation), and click OK. With no HTTPS authentication configured, you can gain access to ASDM with no username and the enable password, which is blank by default. Note: If you enabled HTTPS authentication, enter your username and associated password.
 
     [bookmark: pgfId-113417] c. Save the installer to your PC, and then start the installer. The ASDM-IDM Launcher opens automatically after installation is complete.
 
     [bookmark: pgfId-113418] d. Enter the management IP address, leave the username and password blank (for a new installation), and then click OK. Note: If you enabled HTTPS authentication, enter your username and associated password.
 
     [bookmark: pgfId-113419] 3. To use Java Web Start:
 
     [bookmark: pgfId-113420] a. Click Run ASDM or Run Startup Wizard.
 
     [bookmark: pgfId-113421] b. Save the shortcut to your PC when prompted. You can optionally open it instead of saving it.
 
     [bookmark: pgfId-113422] c. Start Java Web Start from the shortcut.
 
     [bookmark: pgfId-113423] d. Accept any certificates according to the dialog boxes that appear. The Cisco ASDM-IDM Launcher appears.
 
     [bookmark: pgfId-113424] e. Leave the username and password blank (for a new installation), and then click OK. Note: If you enabled HTTPS authentication, enter your username and associated password.
 
    
 
     
      [bookmark: pgfId-113055][bookmark: 62821][bookmark: 36899][bookmark: 17014]Perform Initial Configuration Using ASDM
 
     [bookmark: pgfId-113056]You can perform initial configuration using the following ASDM wizards and procedures. For CLI configuration, see the CLI configuration guides.
 
      
      	 [bookmark: pgfId-113060]Run the Startup Wizard
 
      	 [bookmark: pgfId-113064](Optional) Allow Access to Public Servers Behind the ASAv
 
      	 [bookmark: pgfId-113068](Optional) Run VPN Wizards
 
      	 [bookmark: pgfId-113074](Optional) Run Other Wizards in ASDM[bookmark: 96015][bookmark: 19429]
 
     
 
      
       [bookmark: pgfId-113076][bookmark: 56941]Run the Startup Wizard
 
      [bookmark: pgfId-113077]Run the Startup Wizard (choose Wizards > Startup Wizard) so that you can customize the security policy to suit your deployment. Using the startup wizard, you can set the following:
 
      [bookmark: pgfId-113090]
 
       
        
         
         	 
           
           	 [bookmark: pgfId-113080]Hostname
 
           	 [bookmark: pgfId-113081]Domain name
 
           	 [bookmark: pgfId-113082]Administrative passwords
 
           	 [bookmark: pgfId-113083]Interfaces
 
           	 [bookmark: pgfId-113084]IP addresses
 
          
  
         	 
           
           	 [bookmark: pgfId-113086]Static routes
 
           	 [bookmark: pgfId-113087]DHCP server
 
           	 [bookmark: pgfId-113088]Network address translation rules
 
           	 [bookmark: pgfId-113089]and more...
 
          
  
        
 
        
      
 
     
 
      
       [bookmark: pgfId-113092][bookmark: 24281](Optional) Allow Access to Public Servers Behind the ASAv
 
      [bookmark: pgfId-113093]The Configuration > Firewall > Public Servers pane automatically configures the security policy to make an inside server accessible from the Internet. As a business owner, you might have internal network services, such as a web and FTP server, that need to be available to an outside user. You can place these services on a separate network behind the ASAv, called a demilitarized zone (DMZ). By placing the public servers on the DMZ, any attacks launched against the public servers do not affect your inside networks.
 
     
 
      
       [bookmark: pgfId-113098][bookmark: 97965](Optional) Run VPN Wizards
 
      [bookmark: pgfId-113099]You can configure VPN using the following wizards (Wizards > VPN Wizards):
 
       
       	 [bookmark: pgfId-113103]Site-to-Site VPN Wizard—Creates an IPsec site-to-site tunnel between two ASAvs.
 
       	 [bookmark: pgfId-113104]AnyConnect VPN Wizard—Configures SSL VPN remote access for the Cisco AnyConnect VPN client. AnyConnect provides secure SSL connections to the ASA for remote users with full VPN tunneling to corporate resources. The ASA policy can be configured to download the AnyConnect client to remote users when they initially connect via a browser. With AnyConnect 3.0 and later, the client can run either the SSL or IPsec IKEv2 VPN protocol. 
 
       	 [bookmark: pgfId-113111]Clientless SSL VPN Wizard—Configures clientless SSL VPN remote access for a browser. Clientless, browser-based SSL VPN lets users establish a secure, remote-access VPN tunnel to the ASA using a web browser. After authentication, users access a portal page and can access specific, supported internal resources. The network administrator provides access to resources by users on a group basis. ACLs can be applied to restrict or allow access to specific corporate resources.
 
       	 [bookmark: pgfId-113115]IPsec (IKEv1 or IKEv2) Remote Access VPN Wizard—Configures IPsec VPN remote access for the Cisco IPsec client.
 
      
 
     
 
      
       [bookmark: pgfId-113117][bookmark: 84736](Optional) Run Other Wizards in ASDM
 
       
       	 [bookmark: pgfId-113118]High Availability and Scalability Wizard—Configure failover or VPN load balancing.
 
       	 [bookmark: pgfId-113119]Packet Capture Wizard—Configure and run packet capture. The wizard will run one packet capture on each of the ingress and egress interfaces. After capturing packets, you can save the packet captures to your PC for examination and replay in the packet analyzer.
 
      
 
     
 
    
 
     
      [bookmark: pgfId-113121][bookmark: 58115]Advanced Configuration
 
    
 
   
 
  
 
  
  
   
   
    [bookmark: pgfId-1001744]Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL:  www.cisco.com/go/trademarks . Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1721R)
 
    [bookmark: pgfId-1001225] 2015 Cisco Systems, Inc. All rights reserved.
 
  
 
  
  
   
   
    [bookmark: pgfId-1001744]Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL:  www.cisco.com/go/trademarks . Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1721R)
 
    [bookmark: pgfId-1001225] 2015 Cisco Systems, Inc. All rights reserved.
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